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Technical Support

ToolPAL 3.0 has a detailed on-line help file that fully explains the use and functions of the program. Please
consult help first when you have a question. If you need further help, Artistry, Inc. offers free technical
support via the following:

• Fax - (972) 618-1166

• Internet - www.artistry.com

 If you prefer to talk to a technical support representative, you may call technical support at (972) 567-2253.
The best time to call is from 6:00p.m. to 9:00 p.m. (central time).

 The first 90 days of support (up to three technical support calls) are free.  Artistry, Inc. charges $2.00 per
minute with $10.00 minimum charge for telephone support after the free technical support has been used
up.  Please have your Visa or Mastercard ready when making the call.

 If a technical support representative is not available, leave a message with the following information:

• Name

• Telephone number

• Product

 A technical support representative will return your call within 48 hours.  All returned technical
support phone calls are made collect using 1-800-CALL-ATT.

 

 

 

 



 Page 1

 $ERXW�7RRO3$/�����

 This user guide was prepared to introduce you to a Windows utility named ToolPAL 3.0.  Using this guide
and the ToolPAL 3.0 software, you will see how ToolPAL can enhance the way you use Microsoft
Windows 95 and Windows applications.

 6\VWHP�5HTXLUHPHQWV

 You will need the following to use ToolPAL 3.0:

• An IBM or compatible PC with an 80386 or higher processor

• 8 MB of RAM, and 4 MB or more of available hard disk space.

• A mouse.
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 You can easily install ToolPAL 3.0 on your PC using its Windows-based installation program.  ToolPAL is
distributed electronically as one file tp95.exe .  After downloading tp95.exe from the Internet, execute
the tp95.exe program to install ToolPAL 3.0.  If you are installing ToolPAL for Windows 3.1, you will use
the file tp31.exe.

 So what are all the tasks ToolPAL 3.0 can do and how does ToolPAL 3.0 work?  Let's first look at how
ToolPAL 3.0 can be used and what it is capable of doing.  Then we'll go though an interactive description
of how you can create tool palettes using ToolPAL 3.0.

 :KDW�'RHV�7RRO3$/�����'R"

 ToolPAL 3.0 is an easy-to-learn and easy-to-use design tool that generates customized Windows tool
palettes that can be used with any Windows application.  ToolPAL 3.0 has a point-and-click interface that
lets you create tool palettes to launch programs, manage up to nine virtual desktops, and command other
Windows applications.

 ToolPAL 3.0's innovative and easily learned mouse-driven approach offers you a tool palette construction
kit that is simple, powerful, and effective.  ToolPAL 3.0 lets you standardize the way you work with
Windows applications.  You can make the application palettes you use look the same—no matter what
Windows application you use.

 Whether you are a seasoned Windows power user or are new to using Windows, ToolPAL 3.0 will save
you time and effort.  You can create Windows tool palettes that have any type of “look and feel” you want.

 

 Tool palettes can be designed to be unobtrusive, with a thin caption bar and small buttons that take up a
small amount of your valuable screen space like the palette shown below designed for launching Internet
applications in Windows 95.
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 Tool palettes may also have a normal-size caption bar.

 

 

 

 

 

 Tool palettes may also have a status bar that can display the time and date in a variety of different formats
that you can choose from.  The ToolPAL status bar also includes an alarm clock and a count-down timer
feature.

 

 In either thin or normal caption size, the button on the left of the ToolPAL 3.0 caption bar displays the
ToolPAL 3.0 system menu and the button on the right minimizes the ToolPAL 3.0 window, making it an
icon.

 ToolPAL 3.0 palettes can also be created without a caption bar.

 

 ToolPAL 3.0 palette windows can be moved easily—even without a caption bar. All you need to do is click
and drag the palette using any part of the palette that's not a button or file folder tab. If you hold down the
Shift key, you can move a ToolPAL 3.0 palette using the left mouse button when you are pointing at a
button or file folder tab.
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 So what is a file folder tab?  ToolPAL lets you create multiple pages of buttons (called palettes) and put
them in the same window.  You can easily switch between palettes using the ToolPAL Palette menu or file
folder tabs, as shown in the next figure.

 

 This ToolPAL applications shows how you can use ToolPAL to organize your Internet applications—as
well as your favorite Internet links.  Palettes can be designed with larger buttons of any size.  Buttons can
be created with any combination of icons, text, and bitmaps.

 

 

 

 

 

 

 Button text can use any Windows font—including TrueType and PostScript.  Notice in the next figure how
ToolPAL 3.0 offers popup Button Help, which is displayed when you point at a button with the mouse
without pressing a mouse button.  To switch between palettes, just click on a file folder tab.
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 The top left button launches Windows 95 Dial-Up Networking.  The button on the bottom row, right-hand
corner is a Windows resource monitor, which shows the state of Windows system resources.  To see more
detail, you just click on the button.

 

 Using ToolPAL 3.0, you can launch Windows applications with more control than Windows 95, other
application program launchers, and Program Manager replacements.  As you can already see, ToolPAL 3.0
can also help your browser navigate the Internet and keep track of your Windows 95 system resources.

 ToolPAL 3.0 has many powerful features.  ToolPAL has a versatile user interface that's very customizable.
ToolPAL can work with any Windows application as its tool bar.  ToolPAL has over 20 different features
that add value to Windows 95 and Windows 3.1—as well as make Windows easier to use.

 ,W
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 Designing and using ToolPAL 3.0 palettes is as easy as 1, 2, 3:

 1. Create the graphical design of your palettes using the built-in button editor.

 You can design and edit ToolPAL 3.0 buttons right on the ToolPAL 3.0 palette using the built-in
button editor, as shown in the next figure.  For more information regarding each control in the button
editor, press the Help button.

    

 To display the button editor, choose Button Editor in the ToolPAL 3.0 Edit menu or press function key
F2. Using the ToolPAL 3.0 button editor, you can easily move buttons by dragging them with the
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mouse.  You can resize buttons by using one of the sizing handles displayed when the button is
selected.  You can also select groups of buttons to drag, then move them as a group or align them to
the top, left, right, or bottom of the group by just clicking on an alignment button in the Button Editor
dialog.

 ToolPAL 3.0 comes with 300 small tool bitmap images that are stored in the file TOOLS.BMP to use
for creating buttons. ToolPAL 3.0 also includes more than 500 icons to use for creating buttons in the
files ICONS1.LIB, ICONS2.LIB, ICONS3.LIB, ICONS4.LIB, and ICONS5.LIB.

 2. Pick the action you want a button to do when it is clicked on.

 The first time you click on a button that does not have a purpose, the Button Action dialog is displayed
so you can choose the action you want a button to do when you click on it.  In ToolPAL 3.0, buttons
can do 20 different kinds of actions.  So far you have learned about three types of button actions:
launching applications, sending commands to a Windows application, and being a resource monitor.
There are still 17 more button actions that ToolPAL 3.0 can do for you.

 3. Use the palette.

 Using ToolPAL 3.0 is as simple as clicking on a button.  After you have designed and created your
ToolPAL 3.0 palettes, all you need to do is click on a button to have ToolPAL 3.0 do your bidding.
ToolPAL 3.0 comes with a variety of demonstration tool palettes to help you learn how to use
ToolPAL 3.0.  You can modify and use these palettes as examples for creating other palettes.

 ToolPAL 3.0 can take up a variable amount of Windows system memory and resources, depending on how
complicated the palettes are that you create.  Most ToolPAL 3.0 applications use 200 kilobytes of memory,
2% of User resources, and 3% of GDI resources.

 Now that you have learned some how some of the ToolPAL 3.0 features work, let’s see how to use and
create ToolPAL palettes in more detail.
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 The ToolPAL 3.0 palettes used in next section of the user guide are included with ToolPAL 3.0.  They
were installed in the same directory ToolPAL 3.0 was installed in when you installed ToolPAL.  You can
either read this section or follow along with it using the demonstration palettes installed with ToolPAL 3.0.
Before we get started, let’s look at some tips on how to use ToolPAL.

 7RRO3$/�����7LSV

 Here are some tips on how to use ToolPAL 3.0 to help get you started quickly.

• If you want to roll up the ToolPAL 3.0 window when you are not using it, just click the right mouse
button on the ToolPAL 3.0 window caption.

To roll the window back down, just the click the right mouse button on the ToolPAL 3.0 window caption
again.

• To make ToolPAL 3.0 an icon and put it behind the other windows on the desktop, double-click the
left mouse button on the ToolPAL 3.0 window caption or press Esc.  When you activate ToolPAL 3.0
again, it will stay on top of all the other desktop Windows if you have configured ToolPAL 3.0 to stay
on top. All you need to do to make the ToolPAL 3.0 window reappear is press Pause.

• If you want to change the caption on a file folder tab, right mouse click on the file folder tab.

• If you want to configure the ToolPAL 3.0 clock displayed on the ToolPAL 3.0 status bar, right mouse
click on the ToolPAL 3.0 status bar.

• Use the right mouse button to display the ToolPAL 3.0 menu.  Remember that ToolPAL 3.0 is very
object oriented.  If you want to display a menu for configuring a specific button, make sure the mouse
cursor is pointing at the button you want to configure when you press the right mouse button.

 
 



 Page 7

• You can move the ToolPAL 3.0 window by pointing the mouse cursor on the ToolPAL 3.0 window
caption, pressing the left mouse button, and dragging the window—just like any other Windows
application.  You can also move the ToolPAL 3.0 window using the left mouse button and pointing at
any other part of the ToolPAL 3.0 window—as long as it's not a button, file folder tab, or the window
border.  If you hold down the Shift key, you can move the ToolPAL 3.0 window using the left mouse
button when you are pointing to a button or file folder tab.

• You can configure each ToolPAL 3.0 window to always be on top of all desktop windows, be a normal
window, or to always be on the bottom of all desktop windows.  Make your choice from the Window
Position menu in the ToolPAL 3.0 View menu.

• When you set up a ToolPAL 3.0 palette with a standard Windows Multiple Document Interface (MDI)
program, a Window menu is added to the ToolPAL 3.0 menu.  This menu lets you cascade and tile the
MDI application's windows—even if the application does not provide this feature. This feature only
works with standard MDI applications such as Microsoft PowerPoint and Visual C++.  It does not
work with applications that don't use a standard MDI interface, such as Microsoft Word and Microsoft
Excel.

• There are three ToolPAL 3.0 dialogs that are very important:  Button Appearance, to choose the icon,
text, and/or bitmap you want to display on a button; Button Editor, to add, delete, move, align, space,
and change the size of buttons; and Button Action, to choose the action you want a button to do when
you click on it.

• You can display the Button Appearance dialog by choosing Button Appearance in the ToolPAL 3.0
Edit menu.  You can also display this dialog by holding down the Shift+Ctrl keys when you click the
left mouse button on a ToolPAL 3.0 button.

• You can display the Button Editor dialog by choosing Button Editor in the ToolPAL 3.0 Edit menu.
You can also display this dialog by pressing function key F2.

• You can display the Button Action dialog by choosing Button Action in the ToolPAL 3.0 Edit menu.
You can also display this dialog by holding down the Ctrl key when you click the left mouse button on
a ToolPAL 3.0 button.

• A button configured as a virtual desktop button can optionally display the windows on the desktop on
the button. You can drag a window on the button to move it within its desktop or from one desktop to
another.

• You can display a menu for a Program Manager group by configuring a button to Display Program
Group Menu and selecting a Program Manager group.

• All of ToolPAL 3.0's shortcut keys are shown in ToolPAL 3.0's menus alongside the menu command.

• All the information about ToolPAL 3.0 palettes are stored in two files:

• Files with the .TP extension store all the information ToolPAL 3.0 needs for constructing the
palettes you use for a set of tasks.

• Files with the .TPC extension store the information ToolPAL 3.0 needs about the menu structure
of the applications you use with ToolPAL 3.0, so ToolPAL 3.0 knows how to ask them to do
specific actions.

 Note:  Both of these files are opened together when you open a palette file with the .TP extension.

 Now that you have a few tips on how to get started using ToolPAL 3.0, let's see how easy it is to create a
custom ToolPAL palette file.
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 Note: If you are using Windows 3.1, this palette file is called Demo32.tp.

 Demo95 has five palettes, as shown in the following figure.

 

 These palettes are Access. (abbreviation for Windows Accessories), Main, WordPad, Notepad, and
WordPad Paste.  If you want to save space and not use file folders, choose Palette in the ToolPAL 3.0
Options menu to display the Palette Options dialog.  Then turn off the “Display folders for all palettes in
group” option and click on the OK button.  To switch between palettes without file folders, choose the
palette name in the ToolPAL 3.0 Palette menu.

 

 The Demo95 window contains a group of ToolPAL 3.0 palettes called a palette group.  The palette group in
this window is referred to as the main palette group, because it is the palette group at the top of the
ToolPAL 3.0 hierarchy.

 You can switch from palette to palette in a palette group by using the ToolPAL 3.0 Palette menu.  You can
also configure buttons to switch from one palette to another when you left-click on the button.
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 Each ToolPAL 3.0 palette has buttons in it and any button can contain another ToolPAL 3.0 palette group.
Each of these palette groups contains one or more palettes.  These palettes are sometimes called child
palettes, because they have a parent palette above them in the ToolPAL 3.0 hierarchy.  If you left-click on
the ToolPAL 3.0 button that has a desktop on it, the following palette is displayed.

 

 8VLQJ�9LUWXDO�'HVNWRS�%XWWRQV

 This palette has nine Virtual Desktop buttons in it.  If you want to go to a different virtual desktop, just
click on a button.  Notice that you can see the windows that are on each Virtual Desktop.  You can left-
click and drag a window from one button to another.  ToolPAL 3.0 provides up to nine virtual desktops.
You can switch between them by using Virtual Desktop buttons or the ToolPAL 3.0 menu.

 Try going to Desktop 5 by clicking on the middle button.  To get back to Virtual Desktop 1, all you need to
do is choose Desktop 1 in the ToolPAL 3.0 Desktop menu.

 Now that we're back on Desktop 1, let's see some of the other things buttons can do.  So far you have seen
buttons that can launch applications, buttons that can command applications, resource monitor buttons,
buttons that can display other button palettes, and Virtual Desktop buttons.  Five button actions have been
discussed and we still have 15 to go.

 If you are following along using ToolPAL 3.0, go ahead and try some of the application launch buttons in
the top row of this palette, then switch back to using file folders and click on the Window Manager button
(second from the left, on the bottom row).
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 The Window Manager button displays the ToolPAL 3.0 Window Manager.  You can also display the
Window Manager by choosing Window Manager in the ToolPAL 3.0 View menu or by pressing Ctrl+W.

 The ToolPAL 3.0 Window Manager has all the features of the Windows Task Manager it replaces and
many more.  It also has a more graphical user interface that gives you more information about an active
window, such as its icon, which virtual desktop it's on, and “Windows power-user stuff” such as the
window handle and module name.

 Using the Switch To button, you can use the ToolPAL 3.0 Window Manager to switch between Windows
applications.  CloseIT closes a Windows application, like the Close button in the Windows Task Manager.
Tile, Cascade, and Arrange Icons buttons also work the same as in the Windows Task Manager.

 The special ToolPAL 3.0 buttons are: ReleaseIT, MoveIT, ToolPAL, and Task Man.

 ToolPAL can be very handy for a Windows programmer to put the application he is debugging on top of
the debugging window in Visual C++ or Visual Basic and keep it there while testing it.  If you are writing
about a Windows application, you can keep it on top of your word processing window to experiment with
while you are writing about it.

 ToolPAL 3.0 Tip:  You can keep ToolPAL 3.0 on top, or not, by choosing from the Window Position
submenu in the ToolPAL 3.0 View menu.

• ReleaseIT reverses the action of TopIT on the selected window.

• MoveIT moves the selected window from the virtual desktop it's on to the current virtual desktop.

• ToolPAL 3.0 closes the Window Manager window and returns you to the ToolPAL 3.0 window.

• Task Man takes you into Windows power-user territory.  Let's click on it and see what happens.
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 Well, this looks simple enough, but what's going on?  The Windows Task Manager is really a window
manager—not a task manager.  It lists the top-level windows currently running in Windows—not the tasks.
That's why the equivalent feature in ToolPAL 3.0 is called Window Manager—not Task Manager.  A
window is a rectangle on your display that a task displays information in.  A task is the program you
execute to run in a window.  A task is synonymous with a Windows executable or a Windows application.
The ToolPAL 3.0 Task Manager lists the Windows tasks currently running.

 7KH�7DVN�7KDW�:RXOG�1RW�'LH

 Have you ever had a Windows application that stopped working, but Windows and other applications
worked OK?  If you did not want to restart Windows, you could try to use the Windows Task Manager to
get rid of the application—but this does not usually work.  Try Terminate using the ToolPAL 3.0 Task
Manager—it always works (or maybe crashes Windows in the process).  Termination is always a risky
business!  Make sure you have saved your data and use Terminate with caution.

 )RU�:LQGRZV�3RZHU�8VHUV

 Besides terminating tasks, you can also terminate DLLs.  Just choose DLLs, instead of Tasks, in the drop-
down list.

 This lists all the DLLs currently active in Windows—and you can terminate any one of them.  What
happens afterward depends on the DLL.  To find out more internal details about either tasks or DLLs, just
double-click on the entry in the list box or click on the Info button.
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 As you can see, this dialog contains a lot of important information for Windows power users that is of little
use to normal Windows users.
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 Now that you have learned about some of ToolPAL 3.0's power-user features,  let's get back to ToolPAL
3.0 features that are useful to everyone.  Let's see how ToolPAL 3.0 works with other Windows
applications.

 To illustrate, let's switch to the Notepad palette by clicking on the Notepad file folder tab or choosing
Notepad from the ToolPAL 3.0 Palette menu.

 

 Note: To turn file folders back on, choose Palette in the ToolPAL 3.0 Options menu and click on the
“Display folders for all palettes in group” check box in the Palette Options dialog.

 Notice how ToolPAL 3.0 automatically loads Notepad for you.  Now you can click on any of the palette
buttons to execute any of the associated Notepad commands: Open, Save As, Cut, Copy, Paste, Undo, Find,
Print Setup, Insert Date and Time, and Exit.  The last two buttons are for the Window Manager and
ToolPAL 3.0 Resource Monitor.  Popup help appears when you point at a button, to give you more details
about its purpose.

 ToolPAL 3.0 Tip: You can configure help to appear in a popup window or on the ToolPAL 3.0 status bar.
You can also turn off ToolPAL 3.0 Button Help.  Choose Button Help in the Options menu to display the
ToolPAL 3.0 Button Help Options dialog.
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 Using this dialog, you can configure how ToolPAL 3.0 Button Help is displayed and how long ToolPAL
3.0 waits before displaying Button Help.

 $V�7LPH�*RHV�%\���

 The ToolPAL 3.0 status bar displays the current time (and also help, if it's configured to do so).  Time and
date can be displayed in a variety of ways.  There is also a count-down timer.  To set up the ToolPAL 3.0
Time Keeper, choose Time Keeper in the View menu to display the Time Keeper dialog.

 

 To find out the details on how to configure the ToolPAL 3.0 Time Keeper, press F1 for help or click the
left mouse button on the Help button in the ToolPAL 3.0 Time Keeper dialog.

 Now let's see how ToolPAL 3.0 works with another Windows application by clicking on the WordPad file
folder tab.
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 Notice how ToolPAL 3.0 automatically loads Windows WordPad for you.  Now click on the Notepad file
folder tab, then WordPad, then Notepad, then WordPad...  Back and forth...  ToolPAL 3.0 automatically
switches Windows applications for you.

 

 Also notice how the WordPad palette is designed to look like the Notepad palette.  Using ToolPAL 3.0, you
can design a set of palettes that all look and work the same way—no matter what your applications are.
The buttons in this palette work the same way the buttons in the Notepad palette work.  Go ahead and try
them to see how they all work the same way.

 Now let's click on the WordPad Paste file folder tab.  Notice how both icons and text are used together on
the ToolPAL 3.0 buttons in this palette.

 

 This palette was designed to show how ToolPAL 3.0's Clip & Save buttons work.  The buttons in this
palette also show how you can use icons and text together on a button.  If you click on the button labeled
“Picture,” the Artistry, Inc. logo stored in Windows metafile format (WMF) is pasted into WordPad.
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  If you click on the button labeled “Text,” the name and address of Artistry, Inc. are pasted into WordPad.
What else can ToolPAL 3.0 store in Clip & Save buttons?  Multiple Clipboard objects and text templates!
If you click on the button labeled “List,” a menu appears for you to choose a Clipboard object.

 ToolPAL 3.0 can store one or many Clipboard objects in a button.  To store a Clipboard object in a button,
choose Save Clip & Save Data in the ToolPAL 3.0 Edit menu.  To paste the object(s) stored in a ToolPAL
3.0 button into a Windows application, just click on the button.
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 A ToolPAL 3.0 text template is a block of text, such as a form letter, that you would like to use over and
over again—but only change a few words in it.  Let's call the words you want to change “variables.”  To
define what is a variable and what is not, we need delimiters.  The first delimiter defines the start of the
variable and the other defines the end.  Both need to be unique.  ToolPAL 3.0 allows up to two characters
for you to define the starting and ending delimiters. It is common to use “<<” for the starting delimiter and
“>>” for the ending delimiter, but you can use any characters you want.  For example, we could copy the
following text into a ToolPAL 3.0 button configured as a text template button:

  <<today's date>>

 <<customer first name>> <<customer last name>>

 <<addr line 1>>
<<addr line 2>>
<<addr line 3>>

 Dear <<customer first name>>,

 I just wanted to write you a short note to thank you for buying ToolPAL 3.0.  I hope you will find it to be a
useful product.  ToolPAL 3.0 was designed to make Windows faster and easier to use by increasing your
day-to-day productivity.  If you have any problems or questions about using ToolPAL 3.0, please feel free
to contact me via the Internet.  My Internet address is <<Internet Email Address>>.

 Regards,

 

 Art English

 

 Now let's click on the Template button and see what appears, as shown in the next figure.
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 In this form letter example, we thank one of our future ToolPAL 3.0 customers for his purchase by typing
in the replacement text for each variable defined in the Clipboard text block.  After we click on OK, the
following text appears:

 December 31, 1996

 Bill Gates

 Microsoft Corporation
1 Microsoft Way
Redmond, WA 98052

 Dear Bill,

 I just wanted to write you a short note to thank you for buying ToolPAL
3.0.  I hope you will find it to be a useful product.  ToolPAL 3.0 was
designed to make Windows faster and easier to use by increasing your
day-to-day productivity.  If you have any problems or questions about
using ToolPAL 3.0, please feel free to contact me via the Internet.  My
Internet address is art@artistry.com.

 Regards,

 

 Art English

 

 Notice the drop-down list in the Paste Data Template dialog. ToolPAL 3.0 remembers all the information
you typed in for each variable name. To retrieve previously typed-in information, click on the down arrow
in the drop-down list to open it and select the line you want. Information for each unique variable name is
saved when you save your ToolPAL 3.0 file. Text templates that use the same variable names can access
the common stored information for that variable name. To clear the information saved for your template's
variables, click on Clear in the Paste Data Template dialog.
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 How many button types have we discussed now—nine or is it 10?  Let's check our list.  So far you have
seen how the following types of buttons work:

• Buttons that can open any Windows registered file type and launch other Windows and MS-DOS
applications

• Buttons that can work with any Windows application and send commands to the application—just like
its own toolbar

• Window Manager buttons

• Resource Monitor buttons

• Virtual Desktop buttons

• Buttons that can store one Clipboard object

• Buttons that can store multiple Clipboard objects (templates work with both types)

• Buttons that can display other button palettes
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 That's eight button types.  You can also create buttons to:

• Display a menu of files to open and applications to launch.

• Switch to other ToolPAL 3.0 palettes in the same way file folder tabs work.

• Display an ornament or decoration that doesn't do anything.  See WELCOME.TP for an example of
using ornamental buttons to create a presentation.

• Load a Program Manager group and display the group as a menu with icons.

• Load another ToolPAL 3.0 palette file.

• Record and play back keyboard macros.

• Run Windows and DOS applications.

• Display system information, such as Windows version, MS-DOS version, memory available, memory
free, and disk drive space available.

• Send keystrokes to other applications.

• Exit Windows.

• Restart Windows.

• Close a window.

Right now, ToolPAL 3.0 has 20 button types and we are planning to add more in the future.  If you have
any suggestions for other button types, please let us know.
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We stated earlier that designing and using palettes was as easy as 1, 2, 3.  We have covered step 3, using
palettes to see what ToolPAL 3.0 is capable of doing.  It's now time to look at steps 1 and 2 to find out how
palettes and the buttons in them can be created. ToolPAL 3.0 has a lot of options and features for creating
palettes. In this section, you will learn the basic concepts and philosophy of creating palettes—but we will
try to avoid excessive detail to keep your learning experience fun and on a fast track.

In the following “hands-on” project, you will learn how to:

• Create palettes

• Configure the appearance of buttons using icons, text, and bitmaps

• Assign actions to buttons

 To begin, let's start with a new palette by choosing New in the ToolPAL 3.0 File menu.  If ToolPAL 3.0
prompts you to save your work from the previous exercise, just say No—unless you have really made
changes you want to save.

 The palette that ToolPAL 3.0 starts with is always the same and uses the same defaults.

 

 The default palette uses file folders, has 12 buttons that are 40 pixels high and wide, has a status bar, and a
thin window caption bar.  The palette is sizable and the buttons automatically rearrange themselves when
you resize the palette.  All these defaults can be changed on a palette-by-palette basis.  Remember that a
palette is synonymous with a file folder.

 Note:  ToolPAL 3.0 has other defaults that are global and apply to all palettes:

• 3D window style, which can be turned on and off in the View menu

• The group of options in the Application Options dialog

• How Button Help is shown

Make sure the Notepad accessory application that comes with Windows is running in the background.  It
does not matter if it is iconized.  ToolPAL 3.0 will need to be able to ask Notepad later about its menu
structure to be able to work with it.
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Now choose Palette in the Options menu so we can modify our new palette and create more palettes.

The first time you choose Palette in the Options menu for a new palette in ToolPAL 3.0, you will be
prompted to save your palette before going further.  Choose Yes, type in a name for your new palette, such
as MYPROJ, in the File Save As dialog that appears, save the file, and then choose Palette Options again in
the Options menu.  ToolPAL 3.0 needs a ToolPAL 3.0 palette file available to provide you with the default
window options in the Palette Options dialog.

ToolPAL 3.0 Tip: The “Make palette the application's toolbar” option causes this palette to behave as the
program's toolbar.  You can turn on this option only if  “Apply to all palettes in group” is turned on.  Also,
“Display folders for all palettes in group” determines whether or not folder tabs are displayed for all the
palettes in the group.  Unchecking “Display folders for this palette” can turn off individual folder tabs.  For
more information about the controls on this dialog box, press the Help button.
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You can change your palette name using the Modify button in the Palette Name group.  Click on Modify
and type in the new palette name “Launch.”  Then choose OK.

$GGLQJ�3DOHWWHV

Let's create a new palette.  Click on the New button in the Palette Name group, type in the name
“Notepad,” and choose OK. The palette created uses the same number and size of buttons as the current
palette selected in the Palette Name drop-down list.

ToolPAL 3.0 Tip: If you want to change palettes while you are using the Palette Options dialog, just
choose the palette name you want to work with in the Palette Name drop-down list.

Now let's put some icons on those blank buttons.

&RS\LQJ�3DOHWWHV

Let's make our Notepad palette work with Notepad—but first let's make a copy of our palette.  Make sure
the palette you want to copy is the active palette by clicking on its file folder tab.  Choose Copy Palette in
the ToolPAL 3.0 Edit menu.  Then choose Paste Palette Into -> Palette Window.  Type in the name
WordPad for your new palette in the dialog that appears and choose OK.  Now you have a WordPad palette
that looks just like your Notepad palette.
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Now change the number of buttons in this palette.  Choose Create Button Array in the Palette Options
dialog to make this change.  A warning dialog will appear to let you know that you are destroying the
buttons currently in your palette by making this change.  Choose Yes, since you have not created any
buttons you need to worry about saving.

In this dialog, choose two rows and four columns of buttons.  For this project, we will not choose another
button size, but if you want to create a palette of buttons that all have a specific size, this is where to do it.
Now choose OK.

If you look at the palette window, you will notice that the palette has changed—interactively.  You can
move the Palette Options dialog  and your palette using their window caption so you can watch the effect of
the changes you apply in the Palette Options dialog as you make them.

Note: Except for being able to move and use the file folder tabs to switch between parent palettes, all other
palette features are disabled.

0RGLI\LQJ�D�%XWWRQ
V�$SSHDUDQFH

Close the Palette Options dialog box and open the Button Appearance dialog by pointing the mouse cursor
at a button and choosing Button Appearance from the ToolPAL 3.0 Edit menu.  You can also click on a
button while holding down Ctrl+Shift to get to this dialog.



 Page 23

Note how the Button Appearance dialog is modeless, like the Palette Options dialog.  You can go back to
the ToolPAL 3.0 window, move it, and even click on buttons.  When you click on a button, a red highlight
appears around the button to indicate that the button you clicked on is the selected button.  The Button
Appearance dialog also changes.  The button name on the window caption changes, along with all the
specifics about the button you are working on.

Go ahead and select the button in the upper-left corner of the Notepad palette.  If you don't have the
Notepad palette as the current palette, click on the Notepad file folder tab or use the ToolPAL 3.0 menu to
switch to the Notepad palette.

The Button Appearance dialog is a tabbed dialog.  ToolPAL 3.0 uses this approach to make it easier for you
to change a button's appearance and even lets you apply file folder tabs to the button palettes you create.
Go ahead and click on the Icon file folder tab so we can put some icons on the buttons in the palette.

ToolPAL 3.0 comes with several icon libraries.  The default libraries are automatically listed in the Icon
File Name drop-down list.  You can switch between icon libraries by selecting them in this drop-down list.
ToolPAL 3.0 can also use icons from executable files (.EXE), Dynamic Link Libraries (.DLL), and icon
files (.ICO).  To add a file to this list, just click on Add.

How easy is it to put an icon on a button? Very!  Just double-click on the icon you want to put on a button
in the icon list box or click on the Apply button.

Now click on a new button to select it and apply another icon.  Try not to get carried away and go too fast;
you might end up applying an icon on top of a button you already set up.
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When you are finished, your palette should look something like the following palette.

If your palette looks different, that's OK too.  ToolPAL 3.0 is for people who want consistency—but it's
also for people who like to customize things to achieve their own special look and feel.

&KRRVLQJ�%XWWRQ�$FWLRQV

To choose actions for your buttons, make sure either the Notepad or WordPad palette is selected, point at
the button in the upper-left corner of the palette with the mouse cursor, and choose Button Action in the
ToolPAL 3.0 Edit menu to display the Button Action dialog.  Since none of the buttons have been assigned
an action, when you click on a button, a ToolPAL 3.0 Tip dialog will be displayed.

ToolPAL 3.0 Tips were designed to help new ToolPAL 3.0 users by providing guidance on using ToolPAL
3.0.  When you don't want to see a ToolPAL 3.0 Tip again, just choose the “Don't display this tip again”
option.  After you choose OK in the ToolPAL 3.0 Tip dialog, the Button Action dialog is displayed.
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The Button Action dialog does not have much in it, but that's about to change.  The Button Action dialog
works just like the Button Appearance dialog.  The difference between these dialogs is the trigger that
changes the dialog's contents.  In the Button Action dialog, the trigger is the Action drop-down list, not a
file folder tab.  ToolPAL 3.0 buttons already have 20 actions—with more planned for the future!  That is
too many file folders to reasonably work with.

Go ahead and choose Send Program Command from the Action drop-down list.  If you want, take some
time to go through all the actions to find out all the details on the actions ToolPAL 3.0 buttons can do and
how the actions can be configured.
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The Button Action dialog is modeless, just like the Button Appearance dialog, and works the same way.
Select a button, select an action, click on Apply, and select another button.

To illustrate, select the Open File Folder button in the ToolPAL 3.0 palette and double-click on the
“File - > Open” command in the list box.  (Double-clicking is a shortcut for clicking on Apply.)  Now go
ahead and select commands for the rest of your buttons.  Then close the Button Action dialog using Apply
& Close.  Now your palette is ready to test and use.

ToolPAL 3.0 Tip:  If you have a large monitor with a lot of screen space, you can click on the Appearance
button in the Button Action dialog to display both the Button Action and the Button Appearance dialogs at
the same time.  Just remember, to apply a button action change, choose Apply in the Button Action dialog.
To change the button's appearance, choose Apply in the Button Appearance dialog.  Don't worry if you
make mistakes.  Just remember to test your palettes to make sure they work the way you designed them.
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Now that you have palettes created for WordPad and Notepad, it's time to associate these palettes with the
application they are going to work with.  Choose the WordPad palette in the Palette Name drop-down list to
make sure it's the selected palette and choose Windows WordPad from the Application to Command drop-
down list.  Then click on Apply.

ToolPAL 3.0 comes with default configurations for many Windows applications, but if the application you
want to configure is not on the list, it is easy to add it.  Let's see how to do this using Notepad.

Switch to the Notepad palette by choosing it from the Palette Name drop-down list.  Click on the Add
button in the Application to Command group—not the Palette Name group. The following dialog is
displayed.
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Choose NOTEPAD.EXE from the list of tasks currently running and type in Windows Notepad for the
application description. Click on OK in the Add Application To Command dialog box and then click on
Apply & Close in the Palette Options dialog box.

You now have two palettes configured to work with two different Windows applications.  As we stated
earlier, ToolPAL 3.0 is easy to use and easy to configure.  All you need to do next is choose the command
you want to associate each button with.

Note:  When ToolPAL 3.0 configures an application to command, it records its directory and file name in
the Executable File edit field in the Palette Options dialog.  Normally there is no reason for you to change
this information.  If ToolPAL 3.0 cannot find your file, it automatically searches the PATH.  If ToolPAL
3.0 still cannot find your file, a warning message is displayed.  If you have moved your file to another
directory or are switching to a new PC with a different directory structure, you can type in the new file
name and path of the executable in this edit field. You can also choose Delete to delete the old reference
and then choose Add to set up a new one.

$SSOLFDWLRQ�1RWHV

Unfortunately not all Windows applications work in a consistent way.  If you choose a default ToolPAL 3.0
consideration, these exceptions have already been taken into account for you.  The ToolPAL 3.0 Help file
also lists the known exceptions and workarounds.

For example, most new versions of Microsoft applications, including Word for Windows 95, cannot handle
commands as fast as ToolPAL 3.0 can send them.  In this case, the option “High speed commands” is not
selected in the Palette Options dialog for these applications.

In some cases, you will need to try several times to associate an application with a palette to get its menu to
appear in the ToolPAL 3.0 Button Action dialog.  After ToolPAL 3.0 has captured the menu structure, you
don't need to reconfigure it for your next palette—just choose the name from the Application to Command
drop-down list.
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If you cannot get a menu from a Windows application, please contact Artistry, Inc. to let us know so we
can remedy the problem.  In the meantime, you can always associate a Windows application with a palette
and use ToolPAL 3.0 keyboard macros or send keystrokes to send commands to the application.

All the default configurations shipped with ToolPAL 3.0 are in the binary file DEFAULT.TPC.  If you
want to set up applications and have these configurations available anytime you create a new ToolPAL 3.0
file, back up your DEFAULT.TPC file and make a copy of the .TPC file of your application, giving it the
name DEFAULT.TPC.  All your new application configurations will now be available anytime you create a
new ToolPAL 3.0 file.

Note: The Send Command Messages option in the Palette Options dialog uses the application's internal
command message numbers to send commands to the application being commanded.  This setting is the
default for Windows 95. It is the most efficient way to send commands, but you must reconfigure ToolPAL
3.0 every time the application you are using with this palette is upgraded. This is the only setting that will
work with Windows 95 32-bit applications.

%XWWRQ�+HOS

As you choose actions for your buttons, ToolPAL 3.0 automatically fills in your “Button Help” for you.
Button Help is the text that appears in the popup help for a button or on the ToolPAL 3.0 status bar when
you point at a button with the mouse cursor.  If you want to enhance or change the help for a button, just
type it in.  ToolPAL 3.0 will not overwrite text in the Button Help field.  ToolPAL 3.0 only fills in the
Button Help for you when the field is empty.

&RQILJXULQJ�/DXQFK�%XWWRQV

There are four ways to configure application launch buttons:

1. Choose Launch Windows Application in the Action drop-down list in the Button Action dialog and
type the name of the application in the “Application to launch” field.

2. Choose Launch Windows Application in the Action drop-down list in the Button Action dialog and
click on Find Exe to browse through your hard disk to find the application to launch.

3. Use the Windows 95 Explorer to drag files from it and drop them on buttons.

4. Choose the Import Program Manager Items menu command in the ToolPAL 3.0 Options menu.

The first two ways to configure launch buttons are much more work that the last two ways, so let's ignore
them for our project.  Dragging and dropping files using the Windows 95 Explorer is easy—but if you have
Program Manager groups already set up, Import from Program Manager is even easier.  Let's see how it
works.

Select the Launch Palette you created and choose Import Program Manager Items in the ToolPAL 3.0
Options menu to display the Import Program Manager Items dialog.
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The Import Program Manager Items dialog is modeless, like the Button Action dialog, and works in a
similar way.  Select a button in any palette that is displayed, double-click on a Program Item (or choose
Apply), and you have set up a button.  All your Program Manager groups are listed in the Program Groups
drop-down list.  To switch to a new group, select the group's name from this drop-down list. Things could
not get much easier—but wait!

Let's consider three more ways to use this dialog:

1. If you want to build a set of palettes that match all your Program Manager groups, choose Build All. If
a palette does not exist with the same name as a Program Manager group, a new palette is created.  If
an existing palette has the same name as a Program Manager group, it is rebuilt, destroying all the
buttons it contains.

2. If you want to rebuild a palette you already have using all the applications in a Program Manager
group, Click on the Rebuild button to display the Create Button Array dialog, as shown in the next
figure.
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After the Create Button Array dialog is displayed, it shows suggested parameters for your rebuilt
palette. You can change any of them: the palette name, button size, and the number of rows and
columns.

ToolPAL 3.0 Tip: Back in the Import Program Manager Items dialog, the number of applications in
the Program Manager group is displayed. This information is useful in deciding how many buttons you
want to create.

3. If you want to create a new palette using all the applications in a Program Manager group, click on the
Create button to display the Create Button Array dialog. This process works the same way as Rebuild.

ToolPAL 3.0 Tip: Using the Import Program Manager Items dialog, you can work with all the palettes
ToolPAL 3.0 is displaying. To switch from palette to palette, just click on it with the mouse. To switch
between file folders in the parent palette, just click on the file folder tab. If your parent palette doesn't
have file folders, you can use the Current Palette drop-down list to switch been parent palettes.

Windows 95 Note: ToolPAL 3.0 uses Program Manager DDE to learn about the Windows 95 program
groups. Using this method, ToolPAL 3.0 cannot learn about any Program Manager groups that are NOT in
the \Start Menu\Programs file folder. To configure launch buttons for applications that are not in  the \Start
Menu\Programs file folder, you need to use one of the other three methods discussed previously, instead of
Import from Program Manager.
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There is quite a bit more to ToolPAL 3.0 than this user guide covers, but at this point you should know
enough about ToolPAL 3.0 to go exploring on your own and figure out how to take advantage of the rest of
ToolPAL 3.0's features.

/HDUQLQJ�7RRO3$/����

One of the best ways to get started learning ToolPAL 3.0 is the Welcome palette.  To open it, use the
Program Manager icon, Welcome To ToolPAL 3.0 Demo, that is installed in your ToolPAL 3.0 Program
Manager group when ToolPAL 3.0 is installed.  You can also open the Welcome palette by left-clicking on
the Open Welcome Palette push button in the Welcome to ToolPAL 3.0 dialog, as described in this user
guide.

All of ToolPAL 3.0's reference documentation is in the ToolPAL 3.0 Help file.  If you are familiar with
Windows Help, you will find Help to be the best way to learn how ToolPAL 3.0 works.  There are “how-
to” topics, tips and tricks, and frequently asked questions.  Context-sensitive help can be reached by
pressing F1 or clicking on the Help button in any dialog.  All the major ToolPAL 3.0 dialogs are
represented as a picture in the Help file.  If you need to learn more about a specific field in a dialog, just
click on it with the mouse for more information.

If all else fails, please contact Artistry, Inc.  The Artistry, Inc. telephone number is (972) 567-2253.  Our
fax number is (972) 618-1166. Please read the technical support section prior to contacting Artistry, Inc.

Now that you have seen what ToolPAL 3.0 can do, this section summarizes ToolPAL 3.0's features.  To
find out more about a particular ToolPAL 3.0 feature, you should consult the ToolPAL 3.0 Windows Help
file.

7RRO3$/�����)HDWXUHV

ToolPAL 3.0 is a versatile Windows tool palette that gives you push-button control over everything you do
in Windows. You can use ToolPAL 3.0 to:

• Launch your favorite Windows applications.

• Automatically launch and display palettes when a ToolPAL 3.0 file is opened by using a Startup
palette.

• Customize Windows applications by creating tool palettes that work with them.

• Easily switch between applications.

• Manage windows and Windows tasks by using the ToolPAL 3.0 Window and Task Manager.

• Record and play back keyboard macros.

• Switch between nine virtual desktops and see the windows on the button.

• Monitor Windows resources by using the ToolPAL 3.0 Resource Monitor.

• Store and retrieve Windows Clipboard objects (text, pictures, and bitmaps) by using ToolPAL 3.0 Clip
& Save buttons.

• Keep track of your day by using the customizable ToolPAL 3.0 Time Keeper, which includes an alarm
clock and count-down timer.

• Manage the windows of any standard Windows Multiple Document Interface (MDI) application by
using the ToolPAL 3.0 Window menu.
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• Design palettes for other users and password protect them so they cannot be altered by anyone but you.

• Display information about your Windows system by using a System Information button.

• Send keystrokes to another application.

• Run Windows and MS-DOS applications by choosing Run in the File menu or using a Run button.

• Exit Windows by choosing Exit Windows in the File menu or using an Exit Windows button.

• Restart Windows by choosing Restart Windows in the File menu or using a Restart Windows button.

• Attach buttons to Program Manager groups.

• Create palettes that attach themselves to an application as its toolbar.

 To customize ToolPAL 3.0, you can:

• Create buttons that can display any combination of icons, text, and bitmaps.

• Design buttons (background, highlight, and shadow) with any colors you want.

• Create buttons with unique sizes by dragging and sizing them with the built-in ToolPAL 3.0 button
editor.

• Design buttons using any text font and color.  Text can be either flat or 3D (raised or inset).

• Create child button palettes inside buttons as cascading menus or independent button palettes.  A
button in a child button palette can also have other button palettes inside it—with no limit on the
hierarchy.

• Use bitmaps as the background for button palettes.

• Use ToolPAL 3.0 file folders to manage button palettes.

• Save palette files that are password protected and use short menus. In short-menu mode, you can
access most of ToolPAL 3.0's run-time features—but you cannot modify the palettes being used.

• Save palette files that don't have menus. Palettes without menus can do only the actions you specify for
the buttons in the palettes. Using this feature with ToolPAL 3.0 configured as the Windows shell, you
can set up Windows systems where users can access and run only the applications you want them to.

 ToolPAL 3.0 buttons can perform the following actions:

• Display an ornament or decoration.

• Open any Windows registered file type and launch any Windows or DOS application and control how
the application is launched (application startup directory, parameters passed to the application, how the
application is shown, the virtual desktop the application is started on, and a limit on multiple
application instances).

• Display a menu of files to open and applications to launch.

• A ToolPAL 3.0 button can be created to execute any command in any Windows application.

• Store and retrieve Clipboard objects.

• Store and retrieve text templates.

• Record and play back keyboard macros.

• Be a Windows Resource Monitor.

• Be a Windows Task Manager.

• Switch to other palettes.
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• Display a child button palette.

• Display a Program Manager group menu.

• Switch to other Virtual Desktops.

• Load another ToolPAL 3.0 palette file.

• Lock any window on top of all other windows using a TopIT button.

• Display information about your Windows system.

• Run Windows and MS-DOS applications.

• Send keystrokes to other applications.

• Exit Windows and restart Windows.

• Close a window.
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License Agreement

We ask that you respect our work in creating ToolPAL 3.0 and respect our copyright protection. By using
this software, you have indicated your acceptance of the terms of the License Agreement. The Artistry, Inc.
Software (the “Software”) enclosed in this package is copyrighted by Artistry, Inc. (“Artistry, Inc.”) or its
suppliers.  All rights reserved.

1. The license is to the original purchaser only, and is not transferable without written permission of
Artistry, Inc.

2.  The original purchaser may use the Software on a single computer at one time.

3• •  The original purchaser may not engage in, or permit third parties to engage in, any of the following:

A. Providing or permitting use of, or disclosing the Software to, third parties.

B. Providing use of the Software in a computer business, network, timesharing, multiple CPU or
multiple user arrangement to users who are not individually licensed by Artistry, Inc.

C. Making alterations or copies of any kind to the Software or documentation (except for a single
copy of the Software for backup or archival purposes).

D. Attempting to un-assemble, de-compile or reverse-engineer the Software in any way.

E. Granting sublicenses, leases or other rights of the Software to others.

F. Making copies, verbal translations or media translations of the user guide.

G. Making telecommunication data transmissions of the Software.

4.  Artistry, Inc. will not be liable for loss of profits, interruption of service or any other special,
consequential or incidental damages.  Artistry, Inc.'s sole liability for breach of warranty will be, at its
option, to provide a copy of corrected  Software or refund the license fee, less a reasonable allowance
for the period of successful use.  Artistry, Inc. disclaims all other warranties, either express or implied,
including but not limited to implied warranties of merchantability and fitness for a particular purpose,
with respect to the Software, the accompanying written materials, and any accompanying hardware.
This limited warranty gives you specific legal rights.  You may have others, which vary from state to
state.

Artistry, Inc. reserves the right to terminate this license if there is a violation of the license.  Upon
termination, for any reason, all copies of the Software must be immediately returned to Artistry, Inc. and
the original purchaser shall be liable to Artistry, Inc. for any and all damages suffered as a result of the
violation.


